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DanasSnje drustvo obiljezeno je naglim rastom i razvojem
informacijske tehnologije (IT), Sto je rezultiralo velikom ovisno$c¢u
drustva, u Sirem smislu, o znanju i kompetencijama osobe u IT
podrucju. | premda ta ovisnost raste iz dana u dan, ljudsko pravo na
obrazovanje i informacije nije proSireno i na IT podrucje. Pojavili su
se problemi koji utje€u na drustvo u cjelini, koji stvaraju prepreke i
udaljavaju ljude od glavnog razloga i motivacije za napredak, od
prilike. Danas, biti racunalno nepismena osoba, znaci biti osoba koja
nije u mogucnosti sudjelovati u modernom drustvu, osoba bez prilike,
i unato¢ priznatoj neophodnosti i korisnosti inkluzivne informaticke
pismenosti, od strane Europske komisije, UNESCO-a, OECD-a i ostalih
relevantnih institucija, joS uvijek postoje grupe ljudi sa oteZanim
pristupom osnovnoj racunalnoj naobrazbi (npr. osobe s invaliditetom,
osobe s potesko¢ama u ucenju, radnice/i migranti, nezaposlene
osobe, osobe koje Zive na udaljenim mjestima gdje nemaju pristup

racunalnoj edukaciji).

Ove skripte, zajedno sa ostalim materijalom objavljenim na stranici
ITdesk.info, predstavljaju nas doprinos realizaciji i promociji ljudskog
prava na edukaciju i informacije u IT podruc¢ju. Nadamo se da ¢e Vam
ova edukacija pomodi u savladavanju osnovnih racunalnih vjestina i s
tom nadom Zelimo Vam da naudite $to viSe i tako postanete aktivni/a

¢lan/ica modernog IT drustva.

Iskreno Vasi,

ITdesk.info team

I'Tdesk.info
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MICROSOFT POWERPOINT 2010 BETA — ELEMENTI SUCELJA
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Gumbi za manipulaciju prozorom — minimiziranje, maksimiziranje, zatvaranje prozora
. Naslovna traka — ime dokumenta, nastavak (.pptx) te ime programa
3. Kartice / tabs
Datoteka / File
Pocetna / Home

Animacije / Animations
Pokretanje prezentacije / Slide Show
Umetni / Insert Prikaz / Review

Pogled / View

o O O O

Dizajn / Design

o O O O O

Prijelazi / Transitions

4. Traka s alatima/ Toolbar

o neke skrivene naredbe, imaju strelicu pokraj za otvaranje dodatnih opcija
o zasivljene naredbe se ne mogu trenutno izvrsiti

o naredbe s tri tocke imaju slijed daljnjih naredbi

kartice i alatne trake zajedno se nazivaju vrpca (ribbon)

Polja za unos sadrzaja — ovdje upisujemo tekst, unosimo objekt

Tocka umetanja, mjesto gdje treperi kursor

Prikaz minijatura

Polje za biljeske

L XN e

Trake za horizontalnu i vertikalnu navigaciju (klizaci)

10. Statusna traka - prikazuje podatke o trenutnom poloZaju tocke umetanja na radnoj povrsini i
stanje nekih posebnih funkcija Microsoft PowerPointa-a

11. Horizontalno i vertikalno ravnalo
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OZNACAVANIJE TEKSTA

Umetanje (dodatnog) teksta — pritisnemo lijevu tipku misa unutar predvidenog polja i upisemo tekst.
Izmjena postojeceg teksta - oznacimo tekst koji se Zeli izmijeniti i unesemo novi tekst.
Oznacavanje proizvoljnog teksta:
e pritisnemo i zadrzimo lijevu tipku miSa na pocetku teksta koji Zelimo oznaciti, prijedemo
miSem do kraja te otpustimo lijevu tipku
e postavimo tocku umetanja na mjestu pocetka oznacavanija, pritisnemo tipku Shift te
pritisnemo lijevu tipku miSa na mjestu Zeljenog zavrSetka oznacavanja
Dodavanije biljeski / notes: polje poveéavamo podizanjem gornjeg ruba.

UMNOZAVANJE TEKSTA UNUTAR DOKUMENTA | IZMEDU OTVORENIH DOKUMENATA

Kopiraj / zalijepi (Copy / Paste):
1. oznacimo tekst koji Zelimo kopirati

2. kopiramo oznaéeni dio teksta pomocu alata Kopiraj (Copy) i =& (Ctrl + C)
3. postavimo tocku umetanja na mjesto gdje Zelimo smjestiti tekst
4. zalijepimo tekst na to mjesto pomocu jednog od alata Opcije lijepljenja / Paste Options

:& (Ctrl +V)

Kopiranje pomocu uhvati — povuci — pusti metode (drag and drop)
1. oznacimo tekst koji Zelimo kopirati
2. na oznacenom tekstu pritisnemo i zadrzimo lijevu tipku misa te pritisnemo i zadrzimo
tipku Ctrl
3. vucemo pokazivac misa
4. otpustimo tipku misa i potom tipku Ctrl. Tekst je zalijepljen na novu poziciju.

IzreZi / zalijepi (Cut / Paste):
1. oznacimo tekst koji Zelimo premjestiti

2. izrezemo oznaceni dio teksta pomocu alata lzrezi (Cut) & (Ctrl +X)

3. postavimo toc¢ku umetanja na mjesto gdje Zelimo smjestiti tekst :

4. zalijepimo tekst na to mjesto pomocu jednog od alata Opcije lijepljenja / Paste Option ﬁ
(Ctrl + V)

Premjestanje pomocu metode uhvati — povuci — pusti: kao i kopiranje, ali bez tipke Ctrl.

BRISANJE TEKSTA

¢ slovo po slovo: Delete - desno od kursora, BackSpace - lijevo od kursora

e brzi nacin - oznacimo Zeljeni dio teksta i pritisnemo tipku Delete
Brisanje jednog ili vise slajdova - oznacimo jedan ili viSe slajdova (pomocu tipke Shift ako su u slijedu,
a Ctrl ako nisu) i pritisnemo tipku Delete.
Hrvatski naziv za slajd je prozirnica.
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Ponistavanje izmjena (Undo) i poniStavanje ponistavanja izmjena (Redo)

Ponigti (Undo) 2.7 Ponovi (Redo) C

Pritiskom na strelicu pokraj alata otvara se padajudi izbornik s listom svih akcija koje smo napravili.

Uvijek prvo oznacimo tekst pa odaberemo Zeljeni alat.

IZBORNIK: DATOTEKA / FILE

plates and Themes Blank presentation

K
i@

L |

Recent Edank Cpr >
poserdation | tenplates template

Helyp Office com Templates -

Alat Spremi (Save) _l“é_ (precica na tipkovnici Ctrl + S)
e Spremiu/Save in - u koju mapu ¢e se datoteka spremiti
e Ime datoteke / File name - upisemo naziv datoteke
e Spremikao tip / Save as type — program u kojem spremamo dokument
Stvaranje nove prezentacije: New > Blank presentation > Create (precica Ctrl + N)
Olaksano je kreiranje novog dokumenta koristenjem predloska (template) — ekstenzija .potx

-

Otvaranje postojeceg dokumenta “d _alat Open (otvaranje vise dokumenata: tipke Ctrl ili Shift)
Ispis / Print:
e Printer — odabiremo pisac
e Copies — broj kopija dokumenta
e Range - raspon:
o All-sve
o Current slide — trenutni slajd
o Custom range — odabir stranica
e Collated —ispisuje se cijela prezentacija od pocetka do kraja, a zatim prema zadanom broju
kopija, Uncollated —ispisuje se prvi slajd prema zadanom broju kopija, zatim drugi itd.
e Sto dase ispisuje: Full Page Slides, Outline, Notes Page, jedan slajd, dva slajda po stranici,...
e ispis: u boji / color, nijansama sive / grayscale, Cisto crno i bijelo / pure black and white
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Dijeljenje / Share - nove mogucnosti koje olak3avaju dijeljenje dokumenata:
e Promijeni tip datoteke / Change File Type, pohranjujemo datoteku u drugom programu
e Kreiraj PDF/XPS dokument / Create PDF/XPS Document — snimanje datoteke u fiksiranom
formatu, ne moze biti lagano promijenjen

Mogucnosti / Options = Options

e kartica “General” > sadrZi polje za unos korisnickog imena

e kartica Spremi / Save > polja za “AutoRecover file location” and “Default file location”

KARTICA: POCETNA / HOME

RlA9-0I= Presentationl - Microsoft PowerPoint

= 5
@ Home Insert Design Transitions Animations Slide Show Review View Format (A @
| A % B Layout | [ bn Headngt A v AL | B | = vdE = I ) B ) & #aFind

J B —I gReset A = '_‘ i = =~ -!"I i —’3/ 2 - | 2. Replace ~
s New \'&3 v A ~ == Z S A K
1 Pavte ¥ Srl:zé/' E— B 7 U S abe &~ Aa A = ™. ha'pes rravnge s%ﬂc;v 2~ I Setect~
| Clipboard 1 Slides Font Paragraph " Drawing ¥ Editing
acc-Novi slajd / New Slide (ili tipkovnicom Ctrl+M)
e Enter na tipkovnici (moramo se nalaziti u prikazu slajdova)
Izgled slajdova / Layout === taveut=
Title slide — naslovni slajd Title and content — naslov i sadrzaj Two content — dva polja za sadrzaj
S
Title Slide Title and Content Two Content
Vrsta slova (font): Times New Roman, Verdana, Arial, Calibri itd.
Veliéina slova / Font Size — padajudi izbornik
. . B 7 U |
Oblikovanje teksta |——_
Podebljanje (Bold) Zakosenje (Italic) Podvlacenje (Underline)
-Ctrl +B - Ctrl +1 - Ctrl + U - tipkovna precica

Sjena / Shadow $

Precrtani tekst (Strikethrough): nekakav-tekst

-

Mala slova pretvoriti u velika ili obrnuto: Aa - VELIKA SLOVA / UPPERCASE

- mala slova / lowercase

-

A
Bojanje teksta razli¢itim bojama: alat Font Color ==
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Graficke i numericke liste:

Graficke liste / Bullets i= Numericke liste / Numbering =
e nove oznacene stavke — Enter na tipkovnici, prestanak oznacavanja — dva puta Enter

I
il
(Il
i

Poravnanje teksta

e poravnavanje ulijevo / Align Left, e poravnavanje udesno / Align Right,
e po sredini / Centar, e obostrano / Justify
Ispuna lika > & Shape Fill - - otvara paletu boja

Kontura lika > [ Shape Outline - - otvara paletu boja, izbor vrste i debljine linije
Efektilika > L) shape Effects - - ponudeni efekti: 3D, sjena, odraz, rotacija, itd.

Likovi / Shapes “"** — nakon odabira jednog lika na slajd ga unosimo metodom uhvati-povuci-

pusti ¢ime mu automatski definiramo veli¢inu i polozaj na slajdu

Uredi / Arrange — razmjesta elemente ispred (Bring forward) ili iza (Send to back) drugih likova

TraZenje odredene rijedi ili fraze &
e Nadi/ Find, upiSsemo frazu, Pronadi slijedece / Find Next

Zamjena odredene rijedi:
e Find What — koju rijec trazimo;
e Replace With - ¢ime Zelimo zamijeniti

Kopiranje oblikovanja jednog dijela teksta na drugi - alat Format Painter J

Pomo¢ u MS PowerPointu - Alat Help ) , F1 na tipkovnici

Dok smo smjesteni unutar polja za unos sadrzaja na slajdu mozemo otvoriti karticu Oblikuj / Format
koji sadrzi mnoge od upravo opisanih alata:

RBlE9-0|s Presentationl - Microsoft PowerPoint g Tools)| o B =
m Home Insert Design Transitions Animations Slide Show Review View Format (A @
BEXNOoOg - &X- L shape Fill - [‘}/ A | WagingForward v B~ | g e

AlLLd e - H Abc Abc Abc | |+ [ Shape Outline ~ g & -  [hsendBackward ~ [#] - =

2N > %kl Quick = 286m :

¥ | ‘i Shape Effects = Styles ~ > ;{{3 Selection Pane oA

Insert Shapes Shape Style WordArt Styles 1% Arrange
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KARTICA: UMETANJE / INSERT

\EI =9~ 5 Presentationl - Microsoft PowerPoint o B =X
@ Home Insert Design Transitions Animations Slide Show Review View (A} @
! ‘ SE ,% D) T & A D l B 5% ,
A « B P2l @ A8 45T Q &
Table Picture Clip Screenshot Photo Shapes SmartArt Chart t Text Header WordArt Equation Video Audio
Y Art Album v ¥ Box & Footer x % Y 2/ ¥

Tables Images Hlustrations Links Text Symbaols Media

BEEH

Table

Tablice
e odaberemo alat za umetanje tablice i:
o miSem prelazimo preko kockica ¢ime odredujemo broj stupaca i redaka, ili
o odaberemo opciju Umetni tablicu / Insert Table i upiSemo brojeve
*umetanje tablice je omoguéeno i odmah kada umetnemo novi slajd te odaberemo bilo koji
izgled sa sadrzajem*

e promjena poloZaja tocke umetanja: tipka TAB, tipke sa strelicama na tipkovnici, pritiskom
lijeve tipke misa u Zeljenu celiju
e uredivanje tablice: Table Tools > Obrubi / Borders
> Sjencéanje / Shading
e naknadno umetanje retka ili stupca:
o tocku umetanja smjestimo u celiju gdje Zelimo umetnuti redak ili stupac, pritisnemo desnu
tipku misa te na brzom izborniku odaberemo:
* Umetni > red iznad (Insert > Row Above) ili ispod (Below), ili
*  Umetni > stupac lijevo (Insert > Column Left) ili desno (Right)
e brisanje retka ili stupca - oznac¢imo redak ili stupac, pozovemo brzi izbornik te izaberemo

opciju Obrisi stupce (Delete Columns) ili Obrisi retke (Delete Rows)

2

Slike Picture
e *umetanje je omogucéeno i odmah kada umetnemo novi slajd te odaberemo bilo koji izgled
sa sadrzajem*
e oznacavanje slike radimo pritiskom lijeve tipke miSa na Zeljeni objekt, nakon ¢ega objekt na
obrubu dobije kvadratiée
e podesavanje velicine objekta:
o rucno: oznacimo objekt, metodom uhvati-povuci-pusti (drag and drop) pomic¢emo neke od
rubnih tocaka na okviru objekta
o upisom vrijednosti: desni klik na objekt > Oblikuj sliku / Format Picture > kartica Veli¢ina /
Size > u polja je potrebno unijeti vrijednosti za visinu (Height) i Sirinu (Width)
e dok imamo oznacenu sliku na slajdu mozemo otvoriti karticu Oblikuj / Format koja sadrzi
neke nove mogucénosti oblikovanja:
% Corrections = - alat za ispravke kontrasta, svjetline, izoStrenja
g Color ~ - promjena boja slike kako bi bolje odgovarala ostalom sadrzaju
» Artistic Effects = - alat kako bi slika djelovala kao crtez ili naslikana
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Al
Text
Box  drop) mu odredujemo polozZaj i veli¢inu na slajdu

- alat za unos polja za tekst, nakon odabira alata metodom uhvati-povuci-pusti (drag and

Zaglavlje i podnozje (Header and Footer)
e editiranje / uredivanje: pritisnemo lijevu tipku misa u prostor zaglavlja ili podnoZja, ili: desni
klik: uredi tekst / Edit text

j1 - umetanje datuma i vremena / date and time
_#] - umetanje broja slajda / slide number

Umetanje simbola  S29™27 e £ © 00 © = iy sy @ #® (= 2 @ itd.

Grafikoni ¢hart

e * umetanje je omoguceno i odmah kada umetnemo novi slajd te odaberemo bilo koji izgled
sa sadrzajem*

e automatski se otvara tablica u Microsoft Excel-u za unos podataka

e za dodavanje efekata: ispune bojom 3D, rotacija, sjena, itd. - dvostruki pritisak lijeve tipke
misa na grafikon ili pritisak desne tipke misa na grafikon (poziv brzog izbornika) > Oblikovanje
podrucdja grafikona / Format Chart Area

e promjena vrste grafikona - pritisak desne tipke misa na grafikon (poziv brzog izbornika) >
Change Chart Type > odaberemo vrstu

»

Organizacijski dijagrami, ,SmartArt“ smara

e *umetanje je omogucéeno i odmah kada umetnemo novi slajd te odaberemo bilo koji izgled
sa sadrzajem*

e moZemo premjestati polja kako bi uredili strukturu: lijeva tipka miSem na okvir > uhvati-
povuci-pusti (drag and drop) na Zeljeno mjesto

e moZemo dodavati okvire za unos sadrzaja: oznacimo okvir kojem Zelimo dodati novi okvir,
desnom tipkom misa pozovemo brzi izbornik > Add Shape te odaberemo ispod (below) ili
iznad (above)

e brisanje: oznacimo objekt i pritisnemo tipku Delete

KARTICA: DIZAJN / DESIGN

RPllE9-0|= Presentation1 - Microsoft PowerPoint = B 5%

@ Home Insert Design Transitions Animations Slide Show Review View a @

Sk | | — ECclors v | o
/ y : M Background Styles ¥
] = Aa Aa Aa Aag (@ L%—ﬁﬂ «| [&]Fonts - - /
Page Slide mmuEn —— | hl H= smma | [O] effects~ [ Hide Background Graphics

Setup Orientation ~

'age Setup Themes Background "
Postavljanjem misa iznad predloZenih tema dobivamo pretpregled te teme, Zeljenu temu
primjenjujemo pritiskom lijeve tipke mi$a na nju
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n Caolars =
Fonts =
Ol alati za promjenu boja, fonta i efekata unutar odabrane teme
Orijentacija slajda / Slide Orientation
e Portrait (vertikalno)
e Landscape (horizontalno)

KARTICA: IZMJENE / TRANSITIONS

RllEA9-0|+ Presentationl - Microsoft PowerPoint o B R
Home Insert Design Transitions Animations Slide Show Review View A 9
1 = - ) = 1 .& Sound: [No Sound] v | Advance Slide
,‘jj = i @] <:v¢’ ! —|
= | B v i & Duration: 02,00 5 | [¥] On Mouse Click
None Cut Fade Push Wipe Split = P 138 Apply To All [T After 00:00.00 2
Preview Transition ta This Slide Timing

e za dodavanje vizualnog ili zvuénog (sound) efekta za prijelaz izmedu slajdova
e opcije zaizmjenu slajdova:

On Mouse Click o na klikanje misem / On Mouse Click

After: 00:0000 = | © iliunesemo vrijeme

R N & Duration: 0200
e alat za odredivanje trajanja izmjene

e promjene ée biti primijenjena samo na slajd na kojem se trenutno nalazimo, osim ako ne

o0l Apply To Al

upotrijebimo alat - ,Primjeni na sve” slajdove

KARTICA: ANIMACIJE / ANIMATIONS

RllEA9-0|= Presentationl - Microsoft PowerPoint [ brawi 9,T0015 ‘ o B R
E Home Insert Design Transitions Animations Slide Show Review View Format A @
[ T— A E% 30 Animation Pane b Start * Reorder Animation
X " C |- Trigg D Durat 3
Preview None Appear Fade -| FEffed ,Add . . - 5 n
¥ pt Animation v Ofv's 2 -
Preview Animation Advanced Animation Timing
e za animiranje pojavljivanja, izlaza te putanje gibanja objekata na slajdu
e oznacimo objekt na slajdu te oznacimo jednu od animacija
o  GbAnimationPane pojavljivanje okna s izlistanim animacijama
KARTICA: POKRETANJE PREZENTACIJE / SLIDE SHOW
Rllld 9~ 0|5 Presentationl - Microsoft PawerPoint o W 83
m Home Insen Design Transitions Animations Slide Show Review View 2] 0
“»I“. 'ﬂ = -«'—T ..‘:_r r L " I) V| Play Narrations W Resolution:  Use Current Resolution  ~
2= L 8 3 i L ’7’." J | X [¥] Use Timings
From From Broadcast Custom Set Up Hide Rehearse Record 5lide
Beginning Current Slide  Slide Show Slide Show * | Slide Shaw  Slide  Timings  Show~ (V] Show Media Controls | L] Use Presenter View

| Start Slide Show Set Up Monitors

e From Beginning - pokretanje prezentacije od pocetka (ili tipka F5 na tipkovnici)
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e From Current Slide - ukoliko ne Zelimo krenuti od prvog slajda, kliknemo na slajd od kojeg
Zelimo krenuti (ili tipke Shift i F5 na tipkovnici)

e Broadcast Slide Show — jedna od novih moguénosti MS PowerPoint-a 2010: aplikacija salje
link udaljenim korisnicima te oni mogu pogledati nasu prezentaciju preko Internet
preglednika

e Custom Slide Show — pojavljuje se okvir pomocu kojeg odredimo novi slijed slajdova

e Hide Slide — alat kojim sakrivamo oznaceni slajd tijekom pokretanja prezentacije / slide show

e desna tipka miSem za vrijeme prezentacije pokazat ée nam raspolozive precace za navigaciju:
prethodni slajd / Previous, sljedeéi / Next, idi na / Go To...

KARTICA: PRIKAZ / REVIEW
Bld9-0l= Presentationl - Microsoft PowerPoint o= 52
@ Home Insert Design Transitions Animations Slide Show Review View Cﬁ
v &G % SRR R TE
Spelling Research Translate Language New Compare
- - Comment
Proofing Language Comments Compare

e rijeci koje su krivo upisane biti ¢e podvucene crvenim, valovitim linijama

e podesenja: Language > Set Proofing Language

e alat Spelling v - otvara se dijaloski okvir sa opcijama: ignoriraj jednom, ignoriraj sve,
promijeni, promijeni sve (Ignore once, Ignore all, Change, Change all)

[ ]

> Add to dictionary

KARTICA: POGLED / VIEW

Bl -0 |v Presentationl - Microsoft PowerPoint

’m Home Insert Design Transitions Animations Slide Show Review flew
HCE] | ([ | 2| Ruler ® [ i & color| L1 = Arrange Al
(] JLal L 5 LA -
| Gridiine ' ' il Grayscale — [ Cascade
Normal| Slide Notes Reading Slide Handout Notes A Zoom Fitto ‘ New
Sorter Page  View Master Master Master | Guides Window |l Black and White | windaw 53 Move Spiit

Presentation Views:

Razlic¢iti pogledi na prezentaciju:
¢ Normal (Obican prikaz) - namijenjen izradi prezentacije,

Master Views how oom lor/Grayscale Inde

1= |
Switch
Windows *

Macros

M
Macro

o prikazom minijatura slajdova u lijevom stupcu je olak$ana navigacija , moZe prikazivati

Outline (natuknice) ili Slides (slajdove)

e Slide Sorter (Razvrstavac slajdova) - namijenjen pregledu i reorganizaciji slajdova

e Notes Page — za dodavanije biljeski za govornika
e Reading View - prikaz prezentacije unutar prozora

Zoom

Zumiranje / Zoom — odabir ponudene ili unos vrijednosti

ako se neka rije¢ ne nalazi u rje¢niku tada ju moZemo unijeti u rjecnik oznacivsi je > desni klik
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Tabulatorima mozemo tocno definirati gdje Zelimo da se pomakne tocka umetanja
Postavljanje i upotreba tabulatora:

e ravnalo / Ruler treba biti vidljivo Ll

e ikona tabulatora s lijeve strane ravnala omogucuje nam odabir vrste tabulatora

e na Zeljenu poziciju na ravnalu pritisnemo lijevu tipku misa

e tipkom TAB prelazimo od jednog do drugog tabulatora

e uklanjanje tabulatora: pritisnemo i zadrZzimo lijevu tipku misa na njemu te povu¢emo prema
dolje i potom otpustimo tipku misa
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Ova skripta je namijenjena za u¢enje uz materijale
objavljene na slijedeé¢im linkovima:

* Prirucnik:
http://www.itdesk.info/prirucnik prezentacije microsoft powerpoint 2010.pdf

* Video-prezentacije koje prikazuju rad u Microsoft PowerPoint 2010:
e 1. prezentacija Microsoft PowerPoint 2010

e 2. prezentacija Microsoft PowerPoint 2010

e 3. prezentacija Microsoft PowerPoint 2010

* Probni ispit:
http://www.itdesk.info/primjeri ispita/primjer ispita modul 6.pdf

* Video-prezentacija koja prikazuje rjeSavanje primjera ispita:
http://www.itdesk.info/hrvatski/prezentacije-microsoft-powerpoint-2010-video-rjesenje-ispita/

* Kvizevi koji korisnici/ce sami riesavaju:
o http://www.itdesk.info/hrvatski/prezentacije-kviz-1/

e http://www.itdesk.info/hrvatski/prezentacije-kviz-2/

e http://www.itdesk.info/hrvatski/prezentacije-kviz-3/

(za otvaranje linka koji se nalazi unutar .pdf dokumenta samo pritisnite lijevu tipku misa na jedan
od navedenih linkova. Web stranica na koju link pokazuje ¢e se otvoriti u Internet pregledniku koji
imate instaliran na racunalu.)
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Opdi uvjeti koristenja:

Web stranicu www.ITdesk.info je pokrenula udruga ,,Otvoreno drustvo za razmjenu
ideja - ODRAZI* u sklopu aktivnog promoviranja ljudskog prava na slobodan
pristup informacijama te ljudskog prava na edukaciju.

Slobodno kopirajte i distribuirajte ovaj dokument, uz uvjet da ne mijenjate nista u
njemu!

Nad svim programima i uslugama navedenim na web stranici ITdesk Home na web adresi ITdesk.info
isklju¢ivo pravo posjeduju njihovi autori/ce. Microsoft, Windows, i Windowsxx su registrirani zastitni
znakovi tvrtke Microsoft Corporation. Ostali zastitni znaci koristeni na ITdesk Home Web stranicama
su iskljucivo vlasnistvo njihovih vlasnika/ca. Ukoliko imate pitanja vezana uz uporabu ili redistribuciju
bilo kojeg programa, molimo kontaktirajte autore/ice doti¢nog programa. Sva dodatna pitanja
posaljite na info@itdesk.info.

Ove web stranice sadrzavaju linkove na ostale web stranice ili izvore. ITdesk.info team NIJE
odgovoran za tekstualni i/ili reklamni sadrzaj, odnosno za proizvode koji su na tim web
stranicama/izvorima ponudeni, kao $to NIJE odgovoran niti za sadrzaj koji je putem njih dostupan;
moguénost koriStenja ili toCnost sadrZaja. Linkove koristite na vlastitu odgovornost. Takoder,
ITdesk.info team ne garantira:

e daje sadrzaj na ovim web stranicama osloboden od pogresaka ili pogodan za svaku svrhu,

e da ¢e ove web stranice ili web usluge funkcionirati bez pogresaka ili prekida,

¢ da Ce biti odgovarajudi za vase potrebe,

¢ daimplementacija takvog sadrzaja nece narusavati patente, autorska prava, zastitni znak ili

ostala prava neke trece strane.

Ukoliko se ne slaZete s ovim opéim uvjetima koristenja ili ako niste zadovoljni web stranicama koje
pruzamo, prekinite s koristenjem ovih web stranica i web usluga. ITdesk.info team nije odgovoran
vama, niti tre¢im osobama za bilo koju nastalu Stetu, bila ona direktna, indirektna, slucajna ili
posljedi¢na, povezana s vaSsom uporabom ili proizlazila iz vase uporabe, pogresne uporabe ovih web
stranica ili web usluga. lako vase potrazivanje moze biti bazirano na garanciji, ugovoru, prekrsaju ili
nekom drugom pravnom uporistu, neovisno o nasoj obavijeStenosti o mogucnosti nastanka takve
Stete, oslobadamo se svake odgovornosti. Prihvacanje ograni¢enja nase odgovornosti nuZan je
preduvjet koriStenja ovih web stranica i web usluga.

Svi softveri navedeni u ovom ili drugim dokumentima objavljenim na stranici ITdesk.info su navedeni
samo za edukativne svrhe ili kao primjer te mi, na bilo koji nacin, ne preferiramo navedeni softver u
odnosu na neki drugi softver. Bilo koju izjavu da neki navedeni softver preferiramo vise u odnosu na
drugi, koji se spominje ili ne spominje u materijalima, smatrat ¢e se kao lazni iskaz. Nasu izravnu i
bezrezervnu podrsku imaju jedino softveri otvorenog koda (open source) koji omoguduju
korisnicima/cama da bez prepreka postanu digitalno pismeni, koriste racunalo i sudjeluju u
modernom informatickom drustvu
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